Timelapse 2 Manual (Draft)

Last update June 16, 2015

Saul Greenberg, University of Calgary saul.greenberg@ucalgary.ca
Theresa Godin, Freshwater Fisheries Society, BC

Abstract. Camera traps are field-deployable cameras placed at strategic locations, where they automatically take images at either regular intervals (e.g., every 5 minutes, every hour), or when motion is detected (e.g., an animal or person moving through the scene). Scientists use camera traps for many purposes: to track and count entities (such as people and wildlife) and to track conditions (such as weather and visibility) that occur in a particular place over time. A field person then retrieves the camera's card (e.g., every month or two), and stores the captured images into a computer folder as an image set (the set of images captured by that camera). An analyst then visually examines each image for features of interest to their project, and encodes data describing those features.

The two tools described in this manual simply this last visual examination and encoding step. In brief, the TIMELAPSE TEMPLATE EDITOR tool lets the coordinating scientist create a custom template that defines the project-specific data that he or she wants an analyst to encode. That template is included in each image set folder. An analyst then uses the TIMELAPSE tool to open a particular image set folder. TIMELAPSE automatically goes through all images and extracts information from them (e.g., date and time taken), and categorizes unusual images including dark ones (night time) and corrupted images. The TIMELAPSE interface then displays a series of fill-in fields corresponding to the desired data recorded in the template, along with the image. The analyst then goes through the images, where he or she encodes data by typing, or by selecting from menus, or (for counting) simply clicking on entities in the image.

Because much data entry is repetitive, TIMELAPSE includes various means to copy encoded data over a group of images. Because the scientist may have to find and identify small details in an image, TIMELAPSE includes a magnifying glass, pan and zoom capabilities (where switching images will keep the same pan/zoom levels) and several image enhancement methods. Because data has to be imported by other software (Excel, databases, statistical packages), all data is exported as a CVS file. TIMELAPSE has many other features that are described in this manual.

Note. This manual describes version 2.0 of Timelapse. The software is updated over time, mostly in response to feedback from people like you. Thus some of the information and/or features described in this manual may change. Check for new versions of the software and this manual at http://saul.cpsc.ucalgary.ca/timelapse
## Contents

Part 1. Timelapse2 ................................................................................................................................. 3

1 The Beginning and End ...................................................................................................................... 4
   To Begin ........................................................................................................................................... 4
   After You are Done .......................................................................................................................... 4

2 Getting Ready .................................................................................................................................. 5
   Your Computer ............................................................................................................................... 5
   Downloading the Timelapse Software ............................................................................................ 5
   Downloading the Sample Image Folder and Template ................................................................. 7

3 The Tutorial Scenario ....................................................................................................................... 8
   The Images ....................................................................................................................................... 8
   The Data of Interest ......................................................................................................................... 8

4 Analyzing Images ............................................................................................................................. 9
   Loading your image set .................................................................................................................... 9

5 Timelapse Interface Basics ............................................................................................................. 13
   Navigating through images ............................................................................................................ 13
   Feedback ......................................................................................................................................... 13
   Fill in Fields .................................................................................................................................. 14
   Tools for copying repetitive data .................................................................................................. 15
   Magnifying, zooming and panning ................................................................................................. 16
   The Menus ...................................................................................................................................... 18
   Markers ......................................................................................................................................... 21

6 The Timelapse Workflow ................................................................................................................. 22
   Populate the Fields Common to All Images .................................................................................. 22
   Populate the Fields Common Subsets of Images .......................................................................... 23
   Manage Dark and Corrupt images ................................................................................................. 24
   Analyze your remaining images .................................................................................................... 26

Part 2. Creating Templates .................................................................................................................. 33

7 Introduction to Templates .............................................................................................................. 34

8 Creating a Minimal Template ........................................................................................................ 35

9 Explaining the Minimal Template ................................................................................................ 36

10 Modifying the Minimal Template ............................................................................................... 38
   Editing Fields ................................................................................................................................. 38
   Changing the Order of Fields Displayed in Timelapse ................................................................ 39
   Changing the Column Order Displayed in the Spreadsheet ......................................................... 40

11 Adding New Data Fields as Rows ............................................................................................... 41
   Adding Rows .................................................................................................................................... 41
   Editing Rows ................................................................................................................................... 42
   Adding Items to a Choice’s List ...................................................................................................... 43

12 Changing the Template after the Fact ......................................................................................... 44

13 Appendix – Technical details ....................................................................................................... 45

Part 3. Migrating from Timelapse version 1 to Timelapse version 2 .................................................. 46

14 Introduction .................................................................................................................................... 47

15 Converting Templates .................................................................................................................... 48
   Converting this CodeTemplate.xml file ...................................................................................... 48

16 Converting Data ............................................................................................................................. 50
   Converting the CodeTemplate.xml file ...................................................................................... 50
   Converting the ImageData.xml file .............................................................................................. 50
Part 1. Timelapse2

Part 1 explains and provides a tutorial on how to use the Timelapse tool. This is the tool that will be used by the analyst, i.e., the person analyzing images. The analyst is usually provided with a folder containing an image set (the images to analyze) and a template (which defines the project-specific data to be encoded). The analyst begins by using Timelapse to open that folder.

Part 2 explains and provides a tutorial on how to use the TimelapseTemplateEditor. This is the tool that is usually used by the coordinating scientist to create a custom template that defines the project-specific data that he or she wants an analyst to encode.

Note. What you see when you run the Timelapse program may not exactly match the screen images in this manual, due to updates made in the program after the screen images were taken. These are mostly minor visual differences and/or added features that should not affect your general understanding.
1 The Beginning and End

To Begin

You should have an:

- Timelapse software
- image folder containing a series of images taken by the camera,
- ‘template’.tdb file – by default named TimelapseTemplate.tdb – which defines information specific to your project (see definition below). This file must be placed in the image folder. It will normally be given to you by the biologist managing your project.

The software and an example image folder (including a template) matching those in this tutorial are available on the download page at http://saul.cpsc.ucalgary.ca/timelapse/. We strongly recommend that the reader walk through the exercises by using that image folder. The next section details how to download these.

Definition. The template.tdb is a required file that defines your project-specific data (aka schema). Timelapse uses the template to create the fill-in data fields that appear in the Timelapse window. Timelapse also uses the template to decide how to save the data you enter, and ultimately how your data is exported as a comma separated value (csv) file that can be opened as a spreadsheet. Templates have the suffix ‘.tdb’, which stands for ‘template database’.

These templates are specific to your project, which is why they are usually created by the coordinating scientist.

Part 2 explains how to create a template.

After You are Done

When you are done your analysis, you will end up with two new files in your image folder.

- TimelapseData.ddb is the data database that stores all the data that you entered. It is used internally by Timelapse. Don’t remove it, unless you want to delete all your work.
- TimelapseData.csv is a text file containing all your data that can be read by almost all spreadsheet packages, such as Excel. It is in comma separated values format. It is created when you export your data from Timelapse (via the File menu). It

Important. The TimelapseData.csv file is automatically recreated whenever you use Timelapse on that image folder. Thus if you change anything manually in the ImageData.CSV file (e.g., using Excel), those changes will be lost the next time you run Timelapse.
2 Getting Ready

You will need to do several things to get ready for this tutorial: have a Windows computer with a reasonable screen, download the Timelapse software, and download the sample image set (a folder with various images and a template named TimelapseTemplate.tdb).

Your Computer

Windows. The software runs within Windows. It does not run on Apple iOS. However, it will run on an Apple computer running a Windows emulator.

**Technical Note.** Timelapse requires Microsoft’s .Net framework 4.0, which is likely already installed on your computer if you’ve kept up with Microsoft updates.

However, if you find Timelapse ‘crashing’ on startup, it is likely because the correct .Net framework isn’t installed. The Timelapse website (see next page) gives links that will let you install the .Net framework (this just involves a few button presses – no technical knowledge needed). However, if your machine is managed by an IT person, ask them if it has .Net 4.0, and if not, have them install it.

Good quality screen. Whether or not you use our software, you will be looking at images for (in some cases) very small things. In our experience, the larger your screen and the better its resolution, the easier and more accurate it will be for you to spot things in the images. Note that a projector or basic laptop may work for you, but many are actually low resolution (e.g., 1024 x 768). Small laptops can be problematic for detecting small image items because of their small screens.

Downloading the Timelapse Software

Downloading the software should be straight-forward.

1. Go to [http://saul.cpsc.ucalgary.ca/timelapse](http://saul.cpsc.ucalgary.ca/timelapse). You will see a **Download & Install** link on the left side of that page.
2. Select the **Download & Install** link. You should see something like this section on that page. Follow those instructions closely.

   Required Download: The Timelapse Software
   - Select Timelapse 2 Image Analyst / Template Editor.exe - as a zip file
   1. Download the zip file
   2. Open the zip file (e.g., by double clicking it) and extract the Timelapse2 folder to a place of your choosing (e.g., your Desktop or your My Documents folder).
   3. For ease of use, make a shortcut to those programs and put them in a convenient place for rapid access (e.g., your desktop).
   4. (optional) Delete the zip file.
   5. Open the Timelapse2 folder, which contains the two applications below as well as various other files needed by that software.
      - Timelapse2.exe
      - TemplateEditor.exe
   6. (recommended) While you can start either program from that folder, we recommend that you create shortcuts to those two programs, and put them in a place of your choosing (e.g., your desktop).
      - To create shortcuts, select the application with the right mouse button pressed, and then drag it to your desired location (e.g., the desktop). Windows will then display a menu that includes the option 'Create shortcut here'. Select that.
   7. You should now be able to run the software by double-clicking its icon or shortcut.

3. Start the **Timelapse2** program by double-clicking its shortcut (if you created one), or its icon within that folder. You should see something like this.

4. If you don’t see this, follow the instructions in the ‘Potential problems’ section on that download page, as illustrated below.

   **Potential Problems Running the Timelapse software**
   - Windows Security: Windows may display the following when you first try to run the program. This is a security feature of Windows that you need to over-ride when running the software for the first time. If it does, select More Info, which will then show the option 'Run Anyways'. Select that.
   - The software crashes immediately on startup, or displays an error message saying the .Net framework is missing. Timelapse requires the Windows .Net Framework 4.0. While most up-to-date versions of Windows will already include this, it may be missing from older versions of Windows. If this is the case, install the Microsoft .NET Framework 4.0 (and perhaps optionally) its Service Pack 2. Note that if you have a 'locked down' institutional machine, you may have to get your system administrator to do it for you.

**Tip: Updating the software.** Whenever you start Timelapse software, it checks if an update is available. If so, it tells you and directs you to the Timelapse download page. Alternately, if you join the Timelapse Mailing list, you will receive an email whenever a new version is available.

To update, delete the Timelapse folder, and repeat the above steps to download and install the new version.
Downloading the Sample Image Folder and Template

To help you follow this tutorial, you should download the image folder. This folder contains the set of images and an example template used in this tutorial.

1. Return to the Timelapse download page. You should see an ‘Optional Download’ section something like:

   ![Optional Download: Tutorial Image Set and Template]

   The tutorial manual illustrates how Timelapse works with an image folder that contains an example set of images and a template. Download that folder to work with the tutorial manual.

   *The Tutorial Image Set and Template:*

2. Follow the instructions to download the ‘Tutorial Image Set and Template’ as a the zip file. Uncompress it and put the folder in a location of your choosing.

3. Open the folder. It should contain
   - a small sequence of jpg images
   - a file called `TimelapseTemplate.tdb`

---

**Important Note on the Image File Names.**

The software uses the names of the image files to determine the sequence. This is not normally an issue, as most cameras name images by some common text at the beginning, and then adding a number (padded with leading 0’s) at the end.

- `image0001.jpg`, `image0002.jpg`, …
- `image (00912).jpg`, `image (00913).jpg` ….

Incorrect sorting can occur if the numbering does not contain leading 0’s. For example, consider the sequence:


The alphabetic ordering of the above sequence is actually

- `image1.jpg`, `image10.jpg`, `image11.jpg`, `image2.jpg`, `image3.jpg`… `image9.jpg`, which is not what you want

Leading 0s circumvent this problem, i.e., the files should end in `0001`, `0002`… `0010` rather than `1,2,… 10`.

Various off-the-shelf photo software include facilities to rename your photos.
3 The Tutorial Scenario

The Images

The images used in this tutorial were obtained from a biologist who had set up his camera trap to capture human and wildlife usage near a mountain pass. The camera was configured to take an image every 5 minutes, 24 hours a day. Thus images include both day and night time shots. This generated thousands of images in a single image set.

For our training purposes we’ve only included a small number of them. We’ve also included two night-time shots, and a ‘corrupted’ image (which is not readable) just to show you what the system will do with them.

The Data of Interest

The biologist wants an analyst to encode the following custom data for each image:

- number of goats, bears and / or hikers
- weather (sunny, cloudy or raining)
- analyst’s name (the person analyzing the images),
- comments made by the analyst after examining the images
- ‘publicity images’ are those interesting enough to be used for publicity purposes

The biologist is also interested in data automatically extracted by Timelapse from each image, e.g., the image name, the data and time the image was taken, and the image quality

The biologist had created a ‘template’.tdb file that specifies the above data fields, and has included that file in the tutorial image folder (see Part 2 on how this is done).
4 Analyzing Images

Loading your image set

The first time you load your image set, Timelapse will open each image and do some pre-processing of it. This happens only once. You will see each image displayed briefly on the screen as this happens.

1. **Start the Timelapse2 software** through its icon or shortcut. You should then see something like this. This opening screen contains brief documentation that serves as a reminder of how to use the main features of Timelapse. You can revisit this documentation at any time by selecting from the Help menu.

2. **(optional) Expand the window to the full size of your screen.** This is a suggestion. The larger the window, the bigger and better your monitor, the easier it will be to see details in each image.

3. **Load the images.** Select **Load images from folder**... from the **File** menu. Navigate to the tutorial image folder, and select the TimelapseTemplate.tdb file.
4. **Watch the software pre-process the images.** You will see the system go through each image in turn. After it is done, it will display a summary of what it has found. In this case, we see that out of the total of 36 images, it found 32 light images that are likely daytime shots, 2 images that were quite dark and likely night-time shots, and 1 image that was corrupted and therefore unreadable.

5. *(side note)* **The software may ask you to verify the date format.** Some cameras store their dates in day/month order, while others store it in month/day order. Timelapse tries to determine which this, but sometimes it can't do it with certainty. If that happens, Timelapse will raise a dialog box warning you that it has detected date problems, and perhaps suggest a way to repair the problem. Because this image set has no date problems, you will not see this happen.
6. **The various Timelapse controls** are annotated in the figure below.

7. Examine the control area to see what the software automatically filled in for you. We’ve annotated each of those fields to explain them.

---

**Note.** The software reads *meta-data* embedded in each image to get its date and time. If that isn’t there (meta-data is camera-specific), then it uses the *file modified* time. Give a quick check to make sure that the date and time matches up. If it does for a few images, then it should be fine for all of them except, perhaps, for those images that are corrupted.
8. **Preview the spreadsheet.** From the *File* menu, select *Export as CVS File and Preview in Excel*. If you have Excel installed, something like the following appear. Notice that it contains various headers (top row), and that it has populated the cells with the data that the software has already pre-processed. Each column represents one of the fill-in data fields shown in Timelapse. As the actual column names and their order are specified in the ‘template’.tdb file (see Part 2), their name and order may not correspond with what you see in the interface.

![Excel Preview](image.png)

9. If you open the image folder, you will see two new files
   - **TimelapseData.ddb** is a database created and used by Timelapse to store all the information about this image set. If you quit Timelapse and restart, Timelapse will open this file so you can continue where you left off.
   - **TimelapseData.cvs** is a spreadsheet file generated for you to use. It is in .csv, or comma separated values format, so any spreadsheet should be able to read it. It is re-created and over-written every time you export your work, as in the above step. You (or your project manager) will likely use this file for later analysis (e.g., by a statistics package).

**Important. Modifications to the Excel .cvs file will be lost next time you open Timelapse.** The Timelapse image analyzer generates this spreadsheet file *every time* you export your work. That is, it's a one-way process. If you modify the Excel file, it will not update the fields you see in the Timelapse Analyzer. The only time you should modify the Excel file (if you have to do this at all) is after you are completely done your analysis with the Timelapse tool.

**Backup files.** Whenever you open Timelapse, it creates a backup of the TimelapseData.db file in the Backup sub-directory, where it is renamed TimelapseData.BACKUP.ddb. If something really screws up during your analysis, you can always copy that file back to your working directory and rename it to TimelapseData.db.
5 Timelapse Interface Basics

Before showing you how to analyze your images, we will explain a few basic things about the Timelapse interface, just so we won’t have to explain it later. Have Timelapse running and displaying images so that you can try some of these features out.

Navigating through images

You can do this by one of two ways.

- **The left/right arrow keys on the keyboard** lets you move back and forth through the previous and next images in a sequence. You will likely use these a lot to navigate through your image set. A previous/next image menu item is also available through the View menu.

- **The slider** lets you scroll through your image set simply by sliding it back and forth. This is useful for making larger jumps through your images, or to go to a particular image.

Feedback

- **The Status bar** on the bottom right indicates the image number and the total number of images in the current image set. This total number will be affected by the *view filter* that you can select from the *View menu*, which we will describe shortly. Other feedback information will be displayed in the status bar that reflects what you are doing.

- **Various Dialog Boxes** will appear as needed as you use the system, where they inform you about any issues that it may see and perhaps even offer suggestions of what to do to resolve them.
Fill in Fields

There are four different types of fill-in fields, as illustrated below.

- **Choices** are fields that you fill in by selecting from a pull-down menu (i.e., by clicking the down-arrow at its right). For example, *Weather* has a menu showing thee values that you can select from, where the selected item will then appear in the text box.

- **Counters** are fields used to count things. Its label is actually a button – when you toggle it on, every click on the image will be increase the count – we will explain this later. You can also type a number directly into the count, although this is a less preferred way of doing it for reasons we will explain shortly.

- **Notes** are fields where you can enter some text by typing. An example is the *Comments* field above. Notes that are filled in by the system during pre-processing cannot be edited and are shown greyed-out (e.g., the *File* field above).

- **Flags** are checkboxes that you can select or unselect by clicking on it. When checked, it assumes the value ‘true’, otherwise ‘false’.

- **Delete? Flag** is a field supplied by Timelapse. When checked, it marks the image for deletion. However, deletion doesn’t happen until a later operation, as will be explained in a later section.
• **Tooltips** give additional detail about each field, and appear when you hover your mouse over the field.

![Tooltips example](image)

**Tools for copying repetitive data**

These tools greatly simplify repetitive data entry.

• **Context menus for copying data across images** appear when you right-click on various fields or their labels. These items let you copy data from this field to other images, or data from previous fields to here, or across all image fields. We will describe how these work in a later section.

![Context menus example](image)

• **Copy Previous Values Button**, when selected, copies the data from selected fields into this field. This is a very handy way to encode repetitive data. As illustrated below, all the fields that will be copied are highlighted in green when your cursor is over the Copy button. Whether a field is copyable or not copyable is defined in the template. Pressing the ‘C’ shortcut key while the cursor is on the image has the same effect.

![Copy Previous Values Button example](image)
Magnifying, zooming and panning

- **The magnifying glass** magnifies the area under your mouse cursor as you move over the image. You can control its appearance through the **Magnifying Glass** item in the **Options** menu or through typing the following keyboard shortcuts:
  - **M** – (for Magnifier) while the cursor is on the image toggles its visibility on and off.
  - **U** – increases the magnification Up
  - **D** – decreases the magnification Down

The images below show the magnifying glass set at two different magnification levels, where the analyst is taking a closer look at a white blob that could be a goat. Normally, you will set the magnification to something that makes sense for your image set, and likely leave it there.

- **Zoom** in and out of the image by rotating the **scroll wheel** on your mouse. For example, compare the zoomed-in left image above (with the magnifying glass) to the zoomed image below on the left.

Use the mouse scroll wheel to zoom into the area around the cursor
- **Pan** (scroll) to different regions of a zoomed image by *clicking and dragging* across the image. That is, hold the left button down and move the cursor, as illustrated on the right image. As you do this, the image will scroll to its new position. In the images below, the analyst is panning the image rightwards.

![Before panning](image1.png) ![After panning](image2.png)

- **The Zoom Bookmark** remembers your last zoomed-in region, where it can be applied to any image. The keyboard shortcuts do the following actions, with equivalent commands available through the View menu.
  - B creates a zoom bookmark of that region
  - + zooms to the region saved by the bookmark
  - − zooms out all the way to see the entire image
The Menus

There are several pull down menus. While the meaning of most items should be self-evident, here is a summary. Each menu item also has a tooltip to remind you of its purpose, which will appear when you hover the mouse over it.

File menu

- **Load images from folders** asks you to select the image folder / template of the image set you want to analyze.
- **Export as CVS file** exports your data as a comma-separated values file which can then be viewed in a spreadsheet package such as Excel.
- **Export as CVS file and Preview in Excel** is similar, but it will also try to open the cvs file in Excel (assuming you have Excel installed). This is useful for previewing your data as a spreadsheet.
- **Export this image** lets you save a copy of the current image to a folder of your choosing. The original is kept intact.

  **Note.** There is no **Save** menu item. This is because Timelapse automatically saves all entries as you do them.

Edit menu

- **Copy Previous Values** performs the same action as the Copy Previous Values button.
- **Delete** opens a sub-menu with several options.
  - **Delete the current image** deletes the image but not the data associated with it
  - **Delete the current image and its data** deletes the image and the data associated with it
  - **Delete all images marked for deletion** deletes all images (but not their data) for all images with where the **Delete?** flag is checked
  - **Delete all images marked for deletion and their data** deletes all images and the data associated with them where the images’ **Delete?** flag are checked

All Delete operations raise a dialog box that displays the images to be deleted, and asks for confirmation.

  **Note.** The Delete operation does not actually delete the images. Rather, it moves those images into a sub-folder titled Backups. You can delete the images within that (or the entire folder) at your leisure. However, any deleted data is permanently deleted.

- **Date Correction** opens a sub-menu with several options.
  - **Swap Day and Month** displays a dialog box that will let you swap the Day value with the Month value in the Date field across all images. Some cameras store dates in day/time order, and others in time/day order. While the software tries to figure this out when it first reads in the images, there are cases where it cannot tell (it warns you). This option lets you fix it if needed.
  - **Add Correction Value** displays a dialog box that will let you adjust the date if your field camera was not initialized to the correct date/time. All you have to do is supply the correct date/time for the first image, and all others image dates/times will be adjusted accordingly.
  - **Correct for Daylight Savings Time** raises a dialog box that will let you adjust the date to account for the extra / lost hour during time changes. Most camera traps do not handle time changes automatically.
• **Edit notes for this image set** allows you to edit and save notes that are associated with this image set, e.g., comments as a whole, your own ‘to do’ list, messages to other analysts who may go through these images, etc. Timelapse will also insert various messages in here about particular actions you asked it to do.

![Edit notes for this image set](image)

**Options menu** lets you adjust a few settings on the fly.

• **Controls in Separate Window** toggles the way fill-in fields are displayed, i.e., as a panel on top of the window, or as a resizable floating window that you can move around.

![Controls in Separate Window](image)

• **Audio feedback** toggles audio on and off. Timelapse uses audio to give you feedback of the counts you make while counting (more on counting later). While it can prevent errors, it can be annoying...

• **Magnifying Glass >** provides a sub-menu that triggers the same magnifying actions as previously described, i.e., turning the magnifying glass on and off, and increasing or decreasing the magnification level

• **Show Image Counts** raises the previously described summary dialog of image counts that originally appeared when you first opened an image set.

• **Show Filtered Database Contents** displays a table showing the current state of the data. The row representing the current image is highlighted. As you navigate across images and fill-in fields, the changes are reflected in the table.

• **Date: Swap Day and Month** will swap the Day value with the Month value in the Date box across all images. For example, if the Date is 03/09/2011 (Sept 9, 2011), it will change it to 09/03/2011 (Mar 3, 2011). This option is included because some cameras store dates in day/time order, and others in time/day order. While the software tries to figure this out when it first reads in the images, this gives you the chance to change the order if it got it wrong.

• **Advanced Settings and Operations** are features that are currently in progress. Ignore these for now.
View menu

- **View Next Image / Previous Image** navigate to the next and previous image. The perform the same action as using the left/right arrow keys on your keyboard.
- **Cycle Through Image Differences / View Combined Image Differences** visually displays an image that shows the differences between the current image and / or the previous and next image. This is useful for spotting very small visual changes that you could easily miss. It will be explained in detail later.

The next category of items in the View menu lets you set *filters* that selectively show only some of the images from your image set, where certain operations are applied only to those images.

- **All images** display every single image.
- **Light images** display light images that are also not dark, missing or corrupted. These images will likely be the ones that demand most of your attention.
- **Dark images** display only those images that are very dark, i.e., night-time pictures. This is typically used for you to review night time images in a single batch.
- **Corrupted images** display only those images that are corrupted, i.e., that the program couldn’t read as an image. Again, this is typically used for you to review and code these corrupted images as a single batch.
- **Missing images** display only those images that are no longer present, i.e., where the image file is missing. Missing images are usually those that have been deleted, but where the data still exists.
- **Images marked for deletion** displays all images that have the Delete? flag checked. This lets you review those images before you actually delete them.

Help menu

- **Brief Overview** displays the brief instructions you saw when you first started the.
- **The Timelapse Web Page** will display the main Timelapse web page in your browser.
- **Tutorial Manual** will display the Timelapse Tutorial Manual (a PDF file) in your browser. Note: This is a large file, so it may take some time to load. You need to be connected to the internet.
- **Download Sample Tutorial Images** will try to download the sample images that accompany the Timelapse Tutorial Manual. You can use these images to practice on as you follow the manual’s instructions.
- **Timelapse Mailing List – Join it** will let you join the Timelapse mailing list, which will keep you informed of software updates and occasional news. Mailings are fairly infrequent. All emails are moderated, so spam is highly unlikely. We highly recommend you join, as otherwise you can easily miss updates and bug fixes.
- **Timelapse Mailing List – Send Email** will let you send email to the mailing list.
- **About** gives information about the software (such as its version number) as well as how to contact the Timelapse team if you have issues, problems, or questions.
Markers

In some image sets (such as the one used in this tutorial) counting things can be difficult if:

- there are many entities to count (as it is easy to lose track of what is counted and what wasn’t)
- there are different entities to count (as it is easy to mis-categorize counted items)
- the entities you want to count are visually small (as it is easy to miss things)
- you (or another analyst) want to review the image later to verify what has been counted and what hasn’t been counted.

Markers present an alternative to simply entering a number in a Counter. You count by selecting a Counter, and then clicking over the entities of that type in the image. This also creates a visual marker indicating the location of those entities in the image.

- **Activate a Counter** by selecting the Label (actually a Button) of a particular counter.
- **Create a marker** by left clicking atop the thing you want to count on the image. Note that you must have a Counter selected (selected Counter buttons are blue)
- **Delete a marker** by right clicking on it.

The snapshot below illustrates this. The analyst selected the Goat counter (now in blue). Using the magnifying glass and zoom feature, the analyst scanned the image, identified two goats, and clicked on them. The count automatically increases to 2, and two markers now appear atop the goats. Hovering over a marker raises a tooltip that describes its type (i.e, that it is a goat marker).

Markers matching a selected counter appear in blue (which is also the color of the selected counter button) and all other markers in yellow (matching the color of the other unselected counter buttons).
6 The Timelapse Workflow

Timelapse supports a certain workflow, or sequence of events, that you are likely to follow when analysing your images. The basic steps are:

- Populate the fields that are common to all images, or to large subsets of images
- Manage Dark and Corrupt images (if any)
- Analyze your remaining images one by one

We will discuss each in turn.

Populate the Fields Common to All Images

Some of the fields associated with each image may contain a value that is identical across all images. For example, the analyst (you) will be the only one analyzing this image set, so all images would have the Analyst field set to your name.

You could, of course, enter your name one by one in the Analyst field, but this is tedious indeed. Fortunately, the Timelapse tool lets you copy a value to all images. Let’s use the Analyst field as an example.

1. Type in your name in any image (e.g., the first image displayed).
2. Right click on the Analyzer label to raise the context menu.
3. Select Copy to all. A dialog box will ask you to confirm this action. After you accept, all images will in this filtered view will have its Analyst field set to whatever you typed into it.
4. Test it. Navigate to any other image. You should see that they all contain the same value for the Sampler.
5. Save and preview. The spreadsheet should show the Analyst columns filled in with the same value. Note. Afterwards, you can still change the values in these field if you see exceptions. However, you will have to do this image by image.
Populate the Fields Common Subsets of Images

You can also populate a subset of images with a common data value. To illustrate, we will set the weather across various images.

6. Filter the image set to show only ‘Light Images’ (i.e., no nighttime shots or corrupt images). You do this through the View menu.

7. Start at the first image. Since it shows a sunny scene, set the Weather field to ‘Sunny’ (see left image below).

8. Use the slider or arrow key to scan successive images until there is a change in weather. The images all show sunny weather up to IMG_023.JPG.

9. Right click on the Weather field label to raise the context menu (see right image below). Select Propagate from the last non-empty value to here. Since the last non-empty value was ‘Sunny’, all the images in-between the two images will be filled in with the value ‘Sunny’.

10. IMG_24.JPG is cloudy, so set its Weather field to ‘Cloudy’. If you keep on navigating, you will see that all remaining images are cloudy. At this point, two actions will have the identicals effect.
    a. Navigate to the last image. Then propagate from the last non-empty value to that last image.
    b. Alternately, from IMG_023, select the the context menu’s Copy Forward to end, which copies that value to the end of the image set in this filtered view.

11. Test it. Navigate to any other image. You should see that they all contain the same value for the Sampler.

12. Test it across other filtered views. Filter the image set to show ‘All images’. You should see that the dark and corrupted images will not have their Weather field set.
Manage Dark and Corrupt images

If your image set has many night-time shots, you probably want to deal with them in a uniform way. The same thing goes for corrupted images (hopefully, your camera won’t have any of them). We will use Filters to do this. Typical things you may want to do are to delete them (so they don’t clutter your work), or comment on them (although they are already marked as Dark or Corrupted in the ImageQuality field).

A view filter lets you look at a subset of all your images. You can choose a view filter by selecting one from the View menu, which corresponds to how the tool populated the Image quality field. As previously explained:

- **All images** display every single image.
- **Light images** display light images (those that are not dark or corrupted).
- **Dark images** display only those images that are very dark, i.e., night-time pictures.
- **Corrupted images** display only those images that the program couldn’t read as an image.
- **Missing images** display only those images that are no longer present.
- **Images marked for deletion** displays all images that have the Delete? flag checked.

Now let’s use these view filters to manage the dark night-time images.

1. **Choose Dark images from the View menu.** The first dark image will be displayed. You will also see that the image number / image count at the bottom left says that this is the 1st image of the 2 dark images found in this image set. (If this were a full image that represents images taken over regular intervals, there could be hundreds of such images).

2. **Check that all images are, indeed, dark.** This should be the case, but it never hurts to check. Quickly scroll through them to verify this using the slider or arrow keys.

3. **Example 1. Change any fields that are applicable to only the dark images.**
   a. Set the Comment field text to ‘Night time’ in the first image,
   b. Do a Copy to All to propagate that to the other dark images.

4. **Example 2. Delete the Dark images.**
   a. **Select the Delete? flag for both images.**
   b. Using the Edit menu, select Delete / All images marked for deletion and their data...
      A dialog box below that displays thumbnails of the images to delete, where it asks you to confirm the deletion through both a checkbox and a button. Deletion cannot be undone.
After you confirm deletion, Timelapse will no longer display these images or any data associated with them (for added safety, the images are actually saved in the Backup sub-folder rather than deleted).

5. Do something similar for the single corrupted image. For example, select that filtered view, and add a comment to the Comments box, ‘Image cannot be opened’.

6. **Test it.** If you select Save and Preview, your spreadsheet will now look something like this. Note that IMG_001.JPG and IMG_019.JPG will not appear in the spreadsheet, as they were deleted.

   ![Spreadsheet snapshot]

At this point, many of the basic fields are now done. You are ready to start looking at the actual Ok images.
Analyze your remaining images

This ‘final’ step is where you do most of your detailed work, as you will be visually scanning these images for things to count. We do recognize that different projects will require different levels of visual inspection. For example, motion-activated camera traps usually capture large wildlife which are easy to detect and count vs. the camera traps in our tutorial which takes timelapse images over a very large area where the entities of interest are distant and thus quite small. We focus on this later case for now, i.e., how to use Timelapse to help find and count small entities.

The typical ‘workflow’ per image is summarized below.

1. **Copy repetitive values** that were entered in the previous image.
2. **Set all but the count fields** to match what you see in this image.
3. **Scan the image for the entities you want to count.** Sometimes this may be hard to see, perhaps because the light is bad, or the things you are counting are really far away and thus very small.
   a. Look at common places you expect those entities to be.
   b. Rapidly switch between this and surrounding images by using the left/right arrow keys. Your eye will be drawn to things that change between them.
   c. Use the magnifying glass to see details in high-probability places.
   d. Magnify possible entities to scrutinize them, e.g., if you see something – a dot, whatever – use the magnifying glass to see details
   e. Combine steps b and d: if you see something in the magnifying glass but are unsure if it is actually something of interest, try using the left/right arrow keys to see if it’s the same across images (suggesting it is not something that moves), or if it is no longer there (and thus likely something of interest).
   f. Use the image enhancers via the up / down arrow keys (we will explain this shortly)
4. **Select the counter type, and click on each entity of that type.** A red circle appears where you clicked, and the counter will be incremented. If you left-click, it removes the circle and decrements the count.

We will now illustrate this workflow across various images by example.

To begin, set your filter to *Light Images* and go to the first image. We will go through each image in turn, where we will emphasise various ways to analyze these images efficiently with Timelapse. Along the way, we will introduce additional features available in Timelapse.

**Image 1 (IMG000.JPG).** Introducing scanning, zooming, and rapid switching.

1. **Enter any desired data into all but the counter fields.** For example,
   - Set the ‘Comment’ to ‘A nice day’.
2. **Scan the image for wildlife and hikers.** In this particular image set we would do the following.
   - **Look at common places** you expect those entities to be. In this scene, bears and goats would likely congregate on the meadow, with goats also using the rocky open slopes. There is a hiking trail directly in front of the camera, so you would expect hikers to appear there.
   - **Use the magnifying glass** and/or **Pan and Zoom** to examine details in high-probability places. For example there is a white blob in the upper right corner, which appears to be a goat when...
magnified (see image below). While you could increase the magnification (the U key), the actual image resolution and quality—not its magnification—limits the detail we can see.

- **Rapidly switch between this and surrounding images by using the left/right arrow keys.** You won’t be able to go left, as you are on the first image. If you rapidly switch between this and the next image, you’ll see that the white blob is not there. This confirms your belief that there was a goat on the first image, which has since moved. Note that if you keep the magnifying glass over that spot, you will be able to see the magnified changes between images (if any) within it.

3. **Count the goat** by clicking on the Goat label, and then on the goat.

At this point, we are fairly satisfied that there is nothing in image 1, so we are ready to move to the next image.

**Tip.** Marks are persistent. If you quit and reopen this image set, or go to another image and then return to this one, the marks will still be there. This means you can check (and change) your counts at any time, or that another person can look at what you counted to double-check that you correctly identified and counted all entities.

**Tip.** If you accidentally click on the image and introduce a ‘count’ when you shouldn’t have, simply right-click over the visual marker in the image. This will remove the marker and decrement the count.

**Image 2 and 3 (IMG002.JPG & IMG003.JPG). Introducing Copy Previous Values**

1. Repeat the above process. In this image, the goat is no longer there. However, the earlier comment (It’s a nice day) still apply, but these are not filled in. We could fill it in by retyping and reselecting, but this will become tedious to do across lots of images.

2. Instead, you use the *Copy Previous Values* button on the right.
   - Hover your cursor over the Copy Previous Values button. Various fields change their color to green to match the button’s color. These are the fields that are copyable. For example, we see
that the ‘Weather’, ‘Publicity?’, ‘Comments’ and ‘Analyzer’ field are in green, but that the other fields (including the counters) are not.

- Press the Copy Previous Values button. This copies the contents of all the yellow fields in the previous image to the yellow fields in this image. In this case, only the Comment field will appear to be different (i.e., from empty to ‘A nice day’), as the other fields in this image were already the same as those in the previous image.

The Copy Previous Values button is useful because - most of the time - there is very little difference between one image and the next in a sequence. It’s reasonable for you to press this button on almost every image. If there is something that you want to be different, you can always change that. For example, if everything but the ‘Publicity?’ was identical between images, you can press the Copy button, and then change the ‘Publicity?’ field to the value you really want.

Keyboard shortcut: The C key will also activate Copy Previous Values.

3. Check for goats again. In this image, you see a white blob between the two trees on the right. However, when you rapidly switch between this and the previous and next image, you see it hasn’t move. You interpret it as just a rock in the sunlight.
Introducing Image Differencing

Timelapse includes 3 image enhancers that may help you spot small, easily missed entities by highlighting visual changes between the current image and the previous/next images. All are activated using the up/down arrow keys.

1. **The next differenced image.** If you hit the up arrow key once, you will see something like the image below.

   This image was created by comparing the current image with the next image, and highlighting everything that differs between them. This include differences due to lighting, shadows, slight movements of the camera, and — yes — anglers who appear in a location in one image but not the next one. The status bar on the bottom of the screen will also tell you that you are viewing the *Next differenced image.*

2. Some of the visual differences are caused by changes in lighting (e.g., an outline of the scene is faintly seen in the background), and the wind moving objects (e.g., the leaves on the tree on the left).

3. However, just **above** the cursor is a white blob, which seems uncharacteristic. We could examine this with the magnifying glass, but let’s look at the other enhancement techniques first.
4. **The previous differenced image** will be seen if you hit the up-arrow again (see image below, left side). It is similar to the above differencing method, except that it compares the current and the previous image. Hitting the up arrow key a 3rd time will bring you back to the normal image allowing you to rapidly compare all three.

![Previous differenced image](image1.png)

5. **Surrounding differenced image** will be seen if you hit the down-arrow key (see image above, right side). This image show the visual differences across the previous, current and next image.

6. **Examine the features that attract your attention.** The magnifying glass shows only what is in the original image, in its magnified form. In this case we see it’s a hiker.

7. **Count the hiker.** Click the hiker label (a button) in the ‘Hiker’ counter, and then click on the hiker to count him.
8. **Don’t forget to Copy the previous values** if you haven’t already done so. Because counters (in this particular case) are not copyable, those won’t be changed. However, its always better to set the other values before counting, as what is copyable or not depends on how your biologist in charge has configured the template file.

**Why there are three different differenced images.** The next and previous differences create a composite of the difference between the current image and the next (or previous) one. This means that if an entity (e.g., a goat) appears in 1 image, and that entity moves to a different position in the next image, you will likely see 2 entities in the differenced image. That is, it’s a union of the differences. You would then use the magnifying glass to check which of those actually appears in the current image.

In contrast, the surrounding differences will only show those things that appears in the current image and that does not appear in either of the surrounding images. Thus if you see something there, it is likely only in the current image. You should still check with the magnifying glass.

The utility of a particular differenced image depends highly on how the surrounding images differ from the current one. If visual differences are large, then the differenced image would have quite a bit of ‘white noise’ and thus of little value. While the surrounding differenced image usually works best, there is no guarantee that any of the differenced images will be useful. Still, it is a quick operation to cycle between all of them.

If you don’t know what I’m talking about, don’t worry. Let the visuals attract your attention, and then use the magnifying glass – or flip back to the normal image – to check what is there.

**Images 5 - 8 (IMG_004.JPG – IMG_008.JPG). Practicing Image Differencing**

1. **Repeat the above process** for the next four images. Try rapidly switching back and forth between images, as well as using image enhancement.

2. Did you spot the hiker in Image 6? If you look closely at the visual differences through the magnifying glass, you should see a 2nd hiker next to the first one. Without image enhancement, these hikers would have been very hard to spot.

**Images 9 – 13: You try.**

1. Here is what I found:
   - image 9 (IMG_009.JPG): 3 goats on the far edge of the hillside (image right)
   - image 10 (IMG_010.JPG): 1 goats on the far edge of the hillside (image right)
   - image 11 (IMG_011.JPG): 3 goats, with two on the far rocky slope and one on the right edge of the trees
   - image 12 (IMG_012.JPG): 3 goats on the front right edge of the trees
   - image 13 (IMG_013.JPG): 4 goats in the meadow (just left of image center)
   - image 14 (IMG_014.JPG): 3 goats in the meadow (just left of image center)
   - image 15 (IMG_015.JPG): 8 goats in the meadow (just left of image center)
   - image 16 (IMG_016.JPG): 7 goats in the meadow (just left of image center)
   - image 17 (IMG_017.JPG): 7 goats on the far edge of the hillside (image right)
   - image 18 (IMG_018.JPG): nothing
   - image 19 – 21: (IMG_020.JPG – IMG_22.JPG) 1 goat on the far rocky slope
   - image 22 (IMG_023.JPG): nothing

2. As you do the counts, set the ‘Publicity?’ field on those images with 7 or more goats.

**Images 20 to the end: Another way to copy data**

1. Image 23 (IMG_024.JPG) is too foggy to analyze. Add a comment to the comment field ‘Too foggy to analyze’.
2. Rapidly move through the next images. All are too foggy to analyze except for the last image. Rather than enter the comment on each image, go to the last foggy image, and raise the Comment’s Context Menu. Select ‘Propagate from last non-empty value to here’, which will fill in all the comments on the intervening images.

Tip. The basic idea of the ‘Propagate From…’ feature is that you can fill in a field on one image, and then keep going through subsequent images until the last one that should have that field’s value. You can then ‘backfill’ the entries in your filtered view. However, this only works if those inbetween images has nothing in that field.

Alternately, you can use ‘Copy Forward…’. Again, you can fill in a field on one image. In this case, however, doing a Copy Forward will copy the value in that field, and overwrite it for all subsequent images in the filtered view. You then navigate the subsequent photos until you find something different. You enter the new value on that image and copy forward again. Repeat until you have gone through all images. Of course, you have to be careful not to over-write existing values (if you didn’t fill things in in sequence) and you have to be diligent in this practice, as otherwise you may have filled in fields that you didn’t really want to fill in.

In practice, you may use a combination of all these menu items along with the Copy Previous Value button to fill out these fields efficiently.

Check your work
1. Export and examine the spreadsheet. All relevant fields should now be filled in.
2. Alternately, examine the database. After selecting View / All Images, select Options / Show filtered database contents. This will raise a window showing the current contents of the entire database.

That’s it! If you spot any problems, or if you think of any ways that this tool should be improved, contact Saul Greenberg at saul.greenberg@ucalgary.ca.
Part 2. Creating Templates

Part 1 explained how to use the Timelapse tool. That tool assumes that a template already exists and was included in the image set.

Part 2 explains and provides a tutorial on how to use the TimelapseTemplateEditor. This is the tool that is usually used by the coordinating scientist to create a custom template that defines the project-specific data that he or she wants an analyst to encode.

Note. What you see when you run the TimelapseTemplateEditor may not exactly match the screen images in this manual, due to updates made in the program after the screen images were taken. These are mostly minor visual differences and/or added features that should not affect your general understanding.
7 Introduction to Templates

The kinds of information and things that you and/or your organization want to track and count will be specific to the kinds of images you want to analyze and the particular data you want to get out of it. This information will differ between organizations, and possibly between image sets and biologists. For example, a fisheries person may want to count anglers on a shore and boats on a lake, while a wildlife biologist may want to count large mammals.

The TimelapseTemplateEditor (included with the Timelapse Software) allows you to create a template (a file) specifying the data you want to track. Timelapse will use that template to create the fill-in data fields that appear at the top of the Timelapse window. As described next, you create these templates by filling in a table, where each row of the table specifies the custom data you want.

You should give considerable thought to the information you want to capture and how it is structured. Essentially, you are creating a standard on how your images should be analyzed and – by extension - how you want your data named and recorded, perhaps added to a database via your spreadsheet, and (eventually) analyzed via statistics. We recommend you talk with others in your organization to see what their needs are, where you (perhaps) give them samples of the codes you want to use (or a sample image set with the code template file) to see if it matches their needs.

Important. Once you analyze an image set, you should not add new data fields or delete data fields in the template file used by that image set (i.e., the template stored in the image set folder). This is because the stored data will no longer match the information specified in the code template file. However, you are allowed to modify all but the DataLabel field.
8 Creating a Minimal Template

This exercise will show you how to create the minimum template required by Timelapse. Try it out by using either one of the sample image sets provided with Timelapse, or by creating a folder with a modest sample of images.

1. Start the TimelapseTemplateEditor. It initially displays some brief instructional text.
2. Select the File / New menu item. It will ask you to select a location to save the template file.
3. Save it by its default name (TimelapseTemplate.db) in your test image set folder. The TimelapseTemplateEditor should then display something like this: ¹

You will see four main areas in this display.

- **Data table** (top) where each row specifies a single data item and its attributes.
- **Data interface** (middle) roughly shows how the data will be displayed as fields in the Timelapse user interface. You can drag those fields around to re-arrange their order.
- **Data columns in spreadsheet** (lower) roughly shows how the data will be displayed as columns in the spreadsheet generated by Timelapse. You can also drag those columns around to re-arrange their order.
- **Row addition/deletion** (right) are buttons that let you add or remove particular types of rows into the table.

4. Quit the TimelapseTemplateEditor.
5. Start Timelapse, where you should direct it to your image set folder (which should now contain the TimelapseTemplate.db file). Timelapse will display something like:

¹ There may be differences between the version of the TimelapseTemplateEditor portrayed in this manual and the one you are currently using. Even so, the explanation provided should generally apply to all versions.
If you compare those two images, you will see that the fields shown in Timelapse (as well as their contents) directly mirrors each row in the upper data table of the TimelapseTemplateEditor.

9 Explaining the Minimal Template

Every TimelapseTemplate requires several mandatory data elements, which are automatically added when you create a new TimelapseTemplate. Timelapse tries to fill in most of these data fields when you first process your images. As seen in the previous figure, these comprise several data types, each present as a row in the data table:

- **File**: the name of the image file
- **Folder**: the name of the folder containing that file
- **Date**: the date the image was taken
- **Time**: the time the image was taken
- **ImageQuality**: System-determined image quality. One of
  - i. Ok (if the image was ok);
  - ii. Dark (if the image was mostly black, as in poor quality nighttime shots)
  - iii. Corrupted (if the image cannot be read)
  - iv. Missing (if the image is no longer available)
- **DeleteFlag**: allows you to ‘flag’ particular images for later deletion (see Timelapse manual)

Each data element also has several attributes, as follows.

- **Type**: the type of data. In addition to the above, types include
  - i. **Counters** for counting specific entities in an image, e.g., number of goats
  - ii. **Choices aka Fixed Choices** for choosing from a set of items presented in a menu
  - iii. **Notes** free-form text
  - iv. **Flags** for boolean true / false values
- **Default Value**: the initial value of that data (which may be left empty)
- **Label**: how the corresponding data field should be labelled in the Timelapse user interface
- **DataLabel**: defines how this note appears as a column header in the spreadsheet. This is because some databases may require headings that are not particularly human readable. If left empty, the DataLabel will automatically assume the name as the Label.
• **Tooltip:** defines the text displayed whenever the analyst hovers over a field, or over any marker associated a Counter. This is handy to remind the analyst as to the meaning of the label.

• **Width:** defines the width of the textbox associated with item. Since the units are somewhat arcane, you should figure this one out by trial and error. Ideally, it's just wide enough to fit expected values.

• **Copyable:** Defines whether that field is affected by the ‘Copy Previous Values’ button in the Timelapse tool, that is, that it will copy the data in that field from the previous image into the current image when that button is pressed. If it is true, then copyable field appears in yellow in Timelapse.

• **Visible:** defines whether the field should be displayed in the user interface, and should be set to either true or false. Invisible fields and their default values are still displayed in the spreadsheet. Reasons for having invisible items include:
  - **Reducing clutter** on the Timelapse interface by hiding one of the fields required by the system, e.g., the Folder Name
  - **Reducing complexity while maintaining database consistency** if, for example, a particular image set is known not to have certain entities (such as ‘boats on a lake’ in winter), or if an analyst is interested in only a subset of items
  - **Creating fixed data that should always be present** but that the analyst does not need to see. As an example, each image may be associated with the name of the organization who owns it. To do this, a note could be labelled ‘Organization’ and its DefaultValue set to that organization’s name could be added; if it is set to invisible, it won’t appear on the interface but it will appear on the spreadsheet.

• **List:** Choice data has one additional property, called **List** which contains a series of **Items**. The values of these items define the names of the items in the pull-down menu associated with each fixed choice.

![Choices](image)

**Note.** You cannot delete these required data rows. However, you can edit some of their properties, as will be shown in the next example.

Editable fields are displayed in white, while non-editable fields are in grey.
10 Modifying the Minimal Template

This exercise will show you several basic methods for editing and modifying the template. This exercise uses these methods to modify the minimum template created in Exercise 1.

To begin,

1. Start the TimelapseTemplateEditor.
2. Select the File / Open menu item. Select the location where you had previously saved the template file. Alternately, you can just create a new template and over-write the old one.
3. As before, make sure it is saved by its default name (TimelapseTemplate.db) in your image set folder.

The TimelapseTemplateEditor should now appear the same as that in Exercise 1.

Editing Fields.

We will modify the appearance of the File type, and make the Folder type invisible.

1. Modify the text for the File type by changing its Label from ‘File’ to ‘Image’, the Tooltip text, and by increasing its Width to 200
2. Also modify the Folder type by deselecting its ‘Visible’ property.
3. Quit the TimelapseTemplateEditor, and open Timelapse with the ImageSet to see if the changes worked.

Here is my example below, where we compare it with what is now shown in Timelapse. Note how the image field is now much wider than before.

Note. Not all fields are editable. Editable fields are displayed in white, while non-editable fields are in grey.
Changing the Order of Fields Displayed in Timelapse.

We will change the sort order so that the Date and Time will appear first.

1. Open the TimelapseTemplateEditor as before, with the same TimelapseTemplate.db file.
2. The middle region includes an area that shows how the fields will appear in Timelapse. It should look like:

   ![Image showing field order]

3. Select the ‘Date’ label (not its text box), drag it over the ‘Image’ label, and drop it. The Date field should now be in front of the Image field.
4. Do the same for the ‘Time’ label. You should now see:

   ![Image showing adjusted field order]

5. Quit the editor and open Timelapse. The order of those fields in Timelapse should reflect what you have just done.
Changing the Column Order Displayed in the Spreadsheet

The spreadsheet produced by Timelapse displays the data as columns. We will change the sort order of those columns so that the Folder, Time, Data and File appear in that order.

1. Open the TimelapseTemplateEditor as before, with the same TimelapseTemplate.db file. The bottom region includes an area that shows how the columns appear in Timelapse. It should look like:

```
| File | Folder | Date | Time | ImageQuality | MarkForDeletion |
```

2. Select the ‘Folder’ text and drag/drop it to the left side of the ‘File’ text. The Folder column should now be the first one. Similarly, drag and drop the Time and Date items to their new positions. It should look like:

```
| Folder | Time | Date | File | ImageQuality | MarkForDeletion |
```

3. Quit the editor and open Timelapse. Using the File menu, preview the spreadsheet. The columns in Excel should reflect the above new ordering:

```
A  B    C     D     E     F     G     H
1 | Folder | Time  | Date  | File  | ImageQuality | MarkForDeletion |
2 | testimage | 11:40 AM | 14-Aug-10 | IMG_0200.JPG | Ok | FALSE |
3 | testimage | 11:45 AM | 14-Aug-10 | IMG_0200.JPG | Ok | FALSE |
```
11 Adding New Data Fields as Rows

The power of using templates is that you can add data rows (i.e., new data fields) that are unique to your own projects. As explained earlier, these can be one of four types: count, note, choice, or a flag. This tutorial will show you how to create and modify those four types.

For this exercise, assume you are a biologist who wants to add the following custom data fields that the analyzer should fill in for each image. The type is most appropriate for that field is shown at the right.

- **Sheep**: a count of how many sheep appear in an image   -> **Counter**
- **Goats**: a count of how many goats appear in an image     -> **Counter**
- **Comment**: optional comments about the image               -> **Note**
- **Weather**: sunny, raining, or snowing                       -> **Choice**
- **Publicity Shot**: flags an image as useful for publicity purposes -> **Flag**

We begin afresh. Delete the old TimelapseTemplate.db file from your image set. Then start the TimelapseTemplateEditor, and create a new template (as in Exercise 1).

**Adding Rows**

1. Click on ‘Count’ (right side of display) to add a new row of the type Counter.
2. Similarly, use the buttons to add a Note, a Choice, and a Flag.

The display should be similar to what is shown below. The image annotates, by using red boxes, the way these 5 new fields now appear in the various parts of the interface.
Editing Rows

Using the editing methods in the previous exercise, change the text in the various rows to make them more meaningful. An example is illustrated below. Note that the lower areas will change to reflect what is in the Data Table.

If you make a mistake, you can select a row and delete it using the ‘Remove’ button. Try it by adding a row and then deleting it.

Note that the above edits do the following:

- Specifies an understandable label and tooltip that will be presented in the interface
- Adjusts the width of some of the fields (e.g., wider for comments, smaller for counts as we don’t expect large numbers)
- Makes the counters non-copyable (as we expect counts to change between images)
- Provides a different Data Label for ‘PublicityShot’ vs its label as ‘Publicity Shot’ (Data Labels must be a single word, while Labels can be any text).
- Provides a default value for the ‘Comment field’ i.e., “No comment”

**Very Important Notes on Data Labels.**

- The Data Label identifies your field within Timelapse, as well as in the final spreadsheet.
- If you have edited a particular image set, and change the Data Label in the template, Timelapse will no longer know how to associate that field with the data.
- Data Labels can only contain alphanumeric and the ‘_’ character. No white space is allowed. Timelapse will warn you about that if you type problematic characters.
Adding Items to a Choice’s List

3. Add the three list items to the Weather row. To do this, click in the List textbox, type in “Sunny”, followed by pressing the ‘return’ key on your keyboard. If you click on the ‘v’ key on the right of the menu, you should see that the item has been entered. Similarly, the menu in the example interface will show the same items.

4. Repeat the above with the words ‘Raining’ and ‘Snowing’. The menu should now show all three items.

5. If you need to edit the text in a menu item, select it from the menu so it appears in the text box. Then just edit its contents directly. For example, if you misspelt snowing, you can select that time and type to correct it.

6. For more advanced editing of the list, right click on a menu item after you raise it. You will see a context menu with various option.
   - Move item up / down: moves that menu item up or down the menu
   - Edit: lets you edit the text in that item
   - Delete: deletes that item

7. Quit the editor and start Timelapse. The interface should reflect what you specified, as illustrated below. The Weather pull-down menu is raised to illustrate its contents.

Very Important. If you have already saved some data in Timelapse, you should not add or remove any data rows in the template in that image set. This is because Timelapse stores its data in a manner that exactly reflects the data specified in the template. Adding or removing rows means that they no longer match and the system will crash. Future versions of the editor will remedy this.

For test purposes, just delete the TImelapseData.db file before you try this modified template. Timelapse will read the images afresh.

If you can do all the above, then you should have no problems creating your own custom Code Template file.
12 Changing the Template after the Fact

Timelapse uses the TimelapseTemplate.db file not only to create the interface, but to structure how it stores its data in the TimelapseData.db file. In particular, it uses the Data Label to match the field described in the template to the data stored in the TimelapseData.db. This has implications to how changes to the template are managed after a TimelapseData.db was created.

Consider the case where:

- an analyst has an image set with a TimelapseTemplate.db in it and has begun analyzing those images.
- The analyst (or perhaps someone else) then decides to change the template.
- The analyst tries to reopen the image set for further analysis using the modified template.

What happens next depends upon the changes that were made in the template.

**Changes handled correctly**

- All template text can be edited *EXCEPT* the Data Label
- The position of those fields in the interface and the spreadsheet can be altered

**Changes that generate an error**

- Changing the name of the Data Label: it will no longer match the data label in TimelapseData.db.
- Adding a new row: no data representing that row’s data label is in TimelapseData.db.
- Deleting a new row: no data representing that row’s data label is in TimelapseData.db.

**How Timelapse handles problems**

Timelapse looks for these problem cases and generates an error message saying exactly what is wrong. It then gives you the option of opening up the image set with the original TimelapseTemplate configuration (i.e., it will ignore the modified TimelapseTemplate.db file). An example is shown here.

**You try**

Try altering the template after you’ve created an TimelapseData.db file and then opening up Timelapse again with that image set. You’ll see what changes work and where Timelapse gives you an error message.
13 Appendix – Technical details

Internally, the TimelapseTemplate.tdb is maintained as an SQLite database, where the information you provide is saved as a database table. However, you don't have to know anything about SQL or databases to create these files. The TimelapseTemplateEditor takes care of all the grotty technical details.

The ‘View menu ‘Show All Columns’ displays several non-editable extra columns stored in the database table that are not normally visible. Making these columns visible is useful for debugging purposes, but little else. These extra columns are:

- **ID**: The internal database ID of each row
- **Control order**: represents the sort order for displaying controls (which is used to construct the sample interface in the middle window)
- **Spreadsheet order**: represents the sort order for the spreadsheet columns (which is used to construct the sample interface in the middle window)
Part 3. Migrating from Timelapse version 1 to Timelapse version 2
14 Introduction

The previous version of Timelapse (version 1) used a different file structure to store both the template and the data. If you have used Timelapse 1 and want to migrate your template and/or data to Timelapse 2, the following is for you. However, if you do not have any old templates or data files, you can ignore this section.

The template and data files also have different names across these versions, as listed below.

<table>
<thead>
<tr>
<th></th>
<th>Timelapse1 (version 1)</th>
<th>Timelapse2 (version 2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template file</td>
<td>CodeTemplate.xml</td>
<td>TimelapseTemplate.tdb</td>
</tr>
<tr>
<td>Data file</td>
<td>ImageData.xml</td>
<td>TimelapseData.ddb</td>
</tr>
</tbody>
</table>

The tutorial image folder that you downloaded contains a subfolder titled ‘Files for test conversion’ that contains two files: a sample ImageData.xml file that was created by running Timelapse1 using the CodeTemplate.xml file in the provided image set.

To follow this tutorial, copy those two files into the main folder, and move the existing TimelapseTemplate.tdd and TimelapseData.ddb to somewhere else (e.g. into the ‘Files for test conversion sub-folder’).

Warning. Converting templates should be fairly seamless, with one major exception. New templates require that Data Labels be comprised of alphanumeric characters, with the only other allowable character being an ‘_’. In addition, the Data Label cannot match one of various reserved words.

If your old template used Data Labels with other characters, or if it matched a reserved word, the conversion process will detect that. It will offer alternative Data Labels (e.g., similar labels with the disallowed characters deleted), or a reserved word label modified to include an ‘_’ at its end.) You can also change the Data Label to a new label of your choosing.

However, if you use other software that is based on those old labels (e.g., your own database, or custom program, or statistical analysis tool), that software will have to be modified to these new names.

We are currently working to see if we can fix this, i.e., to allow any names.
15 Converting Templates

The TimelapseTemplateEditor includes a facility that transforms an old CodeTemplate.xml file into a TimelapseTemplate.tdb. For this example, the included CodeTemplate.xml defines fields similar to the one used in the Part 2 Template Tutorial:

- the standard fields (File, Folder, Date, Time, ImageQuality)
- Counters for Sheep and Goats
- A Note called Comment
- A Choice called Weather

The differences between them are as follows:

- Because flags did not exist in Timelapse1, there is no DeleteFlag, or user-provided flag fields
- The Weather label is ‘Weather?’
- The ImageQuality label is ‘Image Quality’
- None of the data labels are filled in (allowed in the old template), which means the Data Label names are copied from the Labels.

**Note:** ‘Weather?’ and ‘Image Quality’ are both problematic, because they have illegal characters when used as a Data Label (i.e., a ‘?’ and a ‘space’). We will see how the TimelapseTemplateEditor handles them.

**Converting this CodeTemplate.xml file**

1. Open the TimelapseTemplateEditor.

2. Select ‘Convert’ rom the File menu,

3. A sequence of dialog boxes will ask you to:
   - Locate the ImageData.xml file that you wish to convert
   - Locate the location for the new TimelapseTemplate.tdb file, where you will also have the option to rename it if you wish.

4. The TimelapseTemplateEditor then converts the file. If it finds an error, it notifies you.
   In the image below, for example, we see that the TimelapseTemplateEditor has raised a dialog box saying that:
   - an illicit character appeared in ‘Weather?’
   - it has changed the Data Label to ‘Weather’.
5. At this point, you can accept the template as is, or modify it further. However, if you want to use data created from that old template, you should hold off modifying it until you read the next section.
16 Converting Data

If you have an old ImageData.xml file, you may want to convert it to the new TimelapseData.tdb format. This will allow you to continue processing it.

However, there are pre-conditions for conversion. Most importantly:

1. You need to have your original image folder that contains:
   - the original images
   - the original CodeTemplate.xml file
   - the ImageData.xml file created by Timelapse when using that CodeTemplate.xml file to analyze the images in this folder.

2. You will need to convert the CodeTemplate.xml file into the new TimelapseTemplate.tdb format. However, you are restricted in the modifications you can make to the TimelapseTemplate.tdb format, as detailed below. Otherwise the new template will not be able to read the old data, or may read it incorrectly.

Converting the CodeTemplate.xml file

1. Following the instructions in the previous section, convert the CodeTemplate.xml file in your old image set folder into the new TimelapseTemplate.tdb format, which should be saved in the same image set folder.

2. You can modify the new template in any way you wish, EXCEPT:
   - Do not add any new fields
   - Do not delete any existing fields
   - Do not change any of the Data Labels.

Converting the ImageData.xml file

3. Start Timelapse2 and load the image set using the new TimelapseTemplate.tdb file. It will scan and read all your images as if they had never been previously analyzed.

4. At the end of scanning new images, Timelapse automatically checks to see if there is an old-style ImageData.xml file in that folder set. If there is, it asks you if you want to import the data already stored in the ImageData.xml file:
5. Select ‘Use Old Data’. Timelapse will then try to incorporate values of your old data.
   - Values are copied from your old ImageData.xml file from the following fields:
     - Date
     - Time
     - All other fields
     - Visual markers indicating where you had clicked for Counter fields are also copied over
   - The following values are not copied from your old ImageData.xml file fields
     - File (as these should not have changed)
     - Folder (in case the folder has been moved to a new place)
     - ImageQuality (as these have changed somewhat in the new system)
     - Delete? (as this did not exist in the previous version).

6. Check your data by
   - Navigating through images
   - examining the spreadsheet
   - selecting Options / Show Filtered Database Contents.